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1. User interface Enhancements 

1.1. Renewed Navibar tool  

The navigation controls are in the bottom right corner of the view and fade when you are not using them. To show the 
navigation controls, move the mouse over the navibar. 
 
2D view: 

      
3D view 

   
 
Zoom in/out and optimal view: 

 Drag the zoom slider or click the + or – to zoom in or out 



 

  

1.2. View Control Bar 

The View Control Bar provides quick access to rules to control the display of elements in different views. 
The View Control Bar includes the following tools: 

 Phase status 
 Phase filters 
 Wall state 
 Opening Detail Level 
 Layer variation groups 
 Input field 

 
The View Control Bar by default is located above the status bar: 

 

1.3. Camera icon on Floor Plan view 

Camera icon allows to view what we would actually see if we were standing at the given location in the floorplan. 
 

 
 

1.4. Welcome Screen – Icon / List view 

Expanding the welcome dialog with a simple list view where all projects are listed with following details: 
Project name | Path | Date and Size form. 
This would allow you to display up to hundreds of projects at once sorted by name, date, etc. 
You can swap the ICON / LIST view to the right side of the dialog. 



 

 

 
 

 
                 



 

  

1.5. Help panel  

On the right side of the screen, the Help palette appear together with Project Navigator by default. 
The Help palette shortly introduces how to use the currently selected tool. It may contains an image (optional) and the 
instructions what to do next when using a tool. 

 
 
If you want to create more space in the drawing area, click the Auto Hide icon in the upper right corner and the Help 
palette disappears behind a tab. To see the Help palette again, hover over the tab, and you see the palettes in a slimmed-
down format. To close the Help palette completely, click the X in the upper right corner.  
To see the Help palette again, select Options > User Interface - Help. 

1.6. Visual keyboard layout for keyboard shortcuts 

Keyboard shortcuts provide an alternative way to execute commands. 
The new ARCHLine.XP 2019 keyboard shortcuts management can boost your productivity. 
 
Each of the keyboard shortcuts assigned to that key is displayed by the visual keyboard when holding the mouse over a 
button for a short time. 
 
Pressing the Ctrl, Shift, Alt buttons rearranges the visual keyboard and displays the keyboard shortcuts available with the 
key pressed. 
 
When you change a shortcut, you can choose Save it as new profile to save the customized shortcut set as a new profile.  
 

https://www.hongkiat.com/blog/how-to-boost-productivity/


 

 

 

1.7. Ribbon bar menu access to most common door / window types 

For elements such as doors and windows clicking on type icons you can place directly the most common door / window 
types. 
In addition clicking on the + icon the program displays the selected category in the Design Center. You can place the 
content of the category with drag and drop method. 
 

     

1.8. Ribbon bar menu access to most common object types 

For elements such as objects, lamps, switches and sockets, cabinets clicking on icons the program displays in Design 
Centre the selected category. You can place the content of the category with drag and drop method. 
 

         
 



 

  

      

1.9. New Paneled Doors 

For The Paneled doors category is extended with 32 new typical paneld doors. 
 

 
 

1.10. New grips 

1.10.1. Parapet height /relative height modifier 

For elements such as doors and windows clicking on the grip will cause the change of parapet height. 
In addition for elements such as object, column, beam clicking on the grip will cause the change height relative to floor. 

1.10.2. Wall marker  

Wall marker on the floor plan displays sides: internal and external. 

 



 

 

1.10.3. New grip points for ceiling, sweep 3D 

Extended grip points help the editing of the selected element. 

  

1.10.4. New rotation grip at 2D elements 

New rotation grip for 2D elements: line, polyline, arc, text, 2D group, raster image. The rotation icon on the right side 
disappears. 

 

1.10.5. Text height modifier 

Selected text height is editable by temporary dimension. 

  

1.11. Nudging Elements 

Nudging is a very simple way to move the selected elements.  
Press the keyboard arrow keys to move the elements horizontally or vertically in specific distance. 
Each press of a keyboard arrow key moves the selected elements with the normal or fine increments. 

 
 
Nudge settings:  
Set up your setting in Option dialog > Snap and Grid panel.  
Default increments:  



 

  

Normal - 100 mm.  
Increment to move the selected elements (Pressing the arrow keys on keyboard) 
  
Fine - 10mm. 
Fine increment to move the selected elements (holding down the SHIFT key then selecting the arrow keys on keyboard) 



 

 

2.  Interoperability 

2.1. Multiple instances of ARCHLine.XP 

Some users are so multitasking that they need everything to be done together or in parallel. ARCHLine.XP 2019 can bring 
them this kind of ease. Now it is possible to run multiple versions of ARCHLine.XP 2019 at the same time. 
 
Using multiple instances of ARCHLine.XP you can copy data from one project to another. 
To copy a part of your floor plan from one project to another, using multiple instances of ARCHLine.XP, simply use the 
copy and paste clipboard commands in Edit menu. 
Note: This function is disabled in Studio version. 
 

 
 



 

  

2.2. Renewed worksharing with Multi-user (team) mode 

The Teamwork tools makes available to work on the same project with your colleagues together. 
Every part of your project updates automatically, so that the plan and the documentation are one coherent unit through the 
lifecycle of it. 
 
Rules of the game: 
 
- Teamwork allows simultaneous access to a shared model through use of a central model. 
- The central model has to be saved on a network drive to which all team members have access. 
- Master working area is privileged to define team project fundamentals (Storey structure, layers, geo-location and initial 
state of the project) 
- All users work locally on different working areas. Every user can manage one working area in active state to which new 
elements are added. 
- Graphic Override enabled to provide different output of the view (color, line types, line weight, half-tone, and hatch 
pattern). 
- Save command means synchronizing local working areas with central model so that other users can see the updated 
workFlow diagram: 

 

2.2.1. Flow diagram for setting up Team project 

1. Administrator creates a new Team project by choosing New project when ARCHLine.XP starts. 
Location of the command: File > Teamwork > New project 
In the Save dialog, Administrator specifies a file name and directory location for the central model on a network 
drive to which all team members (users) have access. 

 
2. Administrator adds new users by defining the name that will be used to login. Password is optional. 
 The following image shows the User administration dialog, adding users. 

 

   
 

3. Administrator will login choosing one of the identity already defined. 
 

 
 

4. The next step is to create the Master working area. Master working area is the only working area where 
password is required to enter. 



 

 

 
 

5. Additional working areas can be created to provide simultaneous access to a shared model for the other users. 

  
 
The following image shows the Working area manager dialog, with two working areas. 
 

  
 

6. Administrator resaves the project. 
 

7. Users can login choosing one of the identity already defined and begin to work on Team projects. 
 



 

  

2.2.2. Setting up working areas 

The workspace is a collection of elements handled by a team member, eg. walls, windows, doors, stairs, etc.  
Only one user can edit each working area at a given time. All users can view the working areas owned by other users, but 
they cannot make changes on it. 
 
The Working area manager dialog provides the following information: 
 

Active  Designates the working area to which new elements are added. 

Working Area Indicates the name of the working area. Click inside the name field to 
rename it 

Current owner Indicates the current owner of the working area. 

Visible Allows to show or hide the working area. 

Editable By default all working area are locked for editing. Choose one or more 
working areas you want to edit. When you take over more than one 
working area you can activate one working area to which new 
elements are added. Working areas currently owned by other team 
members cannot be taken over for editing but they are still visible as 
reference drawings by default. 
Should all the working areas be occupied by other team members 
already you can still login as a passive visitor in READ-ONLY mode. 

Graphic Override Use the Graphic override option when you would like to colour-code 
representation of different working areas for better understanding.  

 

 

Choose the active working area 

User can only create elements in the Active Working Area only. Click on the circle icon in the first column to select your 
active working area. 

Visible 

Choose the working area you want to make visible. You can improve performance if you hide working areas that are not 
required for your current work. 



 

 

Editable 

Choose one or more working areas you want to edit. Working areas currently owned by other team members cannot be 
taken over for editing. 

Graphic Override 

You can specify graphic override of color, line types, line weight, half-tone display, and hatch pattern. 
When the Halftone option is enabled the halftone of the element colour will be used for representation.  
Hatch pattern can be also overridden in case the element has hatch pattern representation. 
 

2.2.3. Changing the Editable Status of working areas 

If you want to create new elements on a different working area you have to close the Team project and open it again. 
 
Login as an user and choose another working area  
 

 
 
You can only set the active state of a working area that is not owned by another user.  
 

  
 

2.2.4. Work offsite or offline  

Change to Offline mode is useful when you are not connected to the network to save your changes. 
 
Working in OFFLINE mode you can work on the project and make changes on your editable working areas far from the 
team, with no network connection.  
Project changes are saved on your hard drive each time you modify and resave the project. 
To share changes with the team members switch back to ONLINE mode when you can do that and save the project file. 
 
Location of the command: File > Teamwork > Administrative Tools >  Creating a Local Copy for Offline mode 



 

  

 
Note: all changes made on this project are not available for other team members until you switch back to ONLINE mode 
and save the project again. 

2.2.5. Update Local Copy to the central model 

Using this command you join again to the Team and synchronize your changes with central model.  
You can update your local changes to the central model and you will see the latest changes from other team members 

2.2.6. Reassign elements to a different working area  

In the drawing area, select elements you wish to reassign. 
Select the target working area. 

2.2.7. Convert Team project to single-user project 

The command converts Team project to single-user project. 
Location of the command: File > Teamwork > Administrative tools > Convert Team project to single-user project 

 Save the project. 

 Exit from the project. 

 Open the project again. From now on you can work in single user mode. 

2.2.8. Change active working area on the View Control Bar 

The View Control Bar always displays the active working area.   
To change the active working area, click on the Drop-down list and select another one. 
You can choose from editable working areas only. 
The active working area drop-down provides the same function as the corresponding dialog clicking on the 
File > Teamwork > Working Area Administration command. 
 

 
 



 

 

2.3. Design Phases 

Using design phases you can separate the building construction into multi-phase design. 
Building renovation projects, or the project complexity often requires to separate in multiple phases. 

Design phase 

The design phase can be Existing and New.  
When creating a new element, it will be associated to the current phase (Existing or New). 
Demolition is NOT a phase you cannot create an element with demolished phase.  
Any elements can be set for demolition with modification command. 
 
The design phases can be tracked in full documentation, so 3D views, sections, elevations, and consignation lists follow 
the status of the current phase. 
 
1. New Elements are created in the New Construction phase. 
2. Existing elements are created in the Existing Phase 
3. Demolished: The element created in the previous phase disappears in the given phase. 
 
Any elements can be set for any other design phase with modification command. Select an element and set the 
 

Phase filters 

Phase filter means rules applying to display of elements based on their phase status: new, existing or demolished.  
ARCHLine.XP comes with 5 phase filters:  

a. All phases 
b. Existing plan 
c. Demolition plan 
d. Existing plan after demolition 
e. New construction plan 
 

The following images display a floor plan with existing wall, demolished window and new window in different phases: 
 
  



 

  

 
Phase filter: Existing plan 
 

 
Phase filter: Demolition plan.  
ARCHLine.XP in 2D marks with red and in 3D automatically refills the void in red left by the demolished window.  
 

 
Phase filter: Existing plan after demolition 
ARCHLine.XP in 3D will automatically refill the void left by the demolished window within the wall. 
 



 

 

 
Phase filter: New construction plan 
 

 
Phase filter: All 
ARCHLine.XP displays all elements with different colors. 
 
The following image displays a real floor plan with different phase filters: 
 

  



 

  

2.3.1. IFC export extended with Design Phase filter 

 
 

 



 

 

2.4. Layer Variations 

Layer variations is a new feature in the organization of project data.   
When the project has entailed so much information that it becomes confusing to understand you can control the project 
visibility by Layer variations.  
Switching between variations you can hide or show the desired part of the project in one step. 
 

 
 

2.4.1. Delete all items on a layer and purge the layer.  

The new toggle button in the bottom left corner of the Layer Properties Manager Dialog allows to delete layers that contain 
items. 
 

  



 

  

3. Architectural Enhancements 

3.1. Join two windows as corner window 

Any combination of standard windows can be joined. 
Wall ends allow window joins. It is allowed to pull them apart and using the trim/extend to wall corner.  
 
There are two methods to create the corner windows: 

1. Automatic 
2. Manual 

Automatic 

To create a corner window place two windows on each side of a corner where two walls meet.  
Using the Join two windows/doors on wall corner command select the first abd second window. 

ARCHLine.XP can create a corner post between two windows. 

Manual 

Select the first window, and drag it to the corner until you see the window snap to the end of the wall. 
 
Using the Resize empty void command you can extend the void separately on left or right side of the door / window, 
breaking the wall properly on wall junction. 

 
 

 
 

3.2. Renewed ramp tools  

Creating a ramp with or without handrails and a landing is easy to accomplish using the renewed Ramp tool, which 
behaves much like the stair tools. 



 

 

3 new tools are available: 
-Straight sloped ramp 
-Arc ramp 
-Two ramp segments connected by a landing 
 
Ramps are drawn going up so they should be drawn from the lower part to higher. 
Ramp cross section is editable by Add Section Profile command 
 

  
 
 
 

3.3. Brise Soleil 

The modern building structures require the brise soleil objects. According the international standard we renamed the 
Outdoor Shader toll to Brise Soliel tool.  
The tool is renewed. The Brise Soleils are ready to use as 3 separate tools in the ARCHLine. 
 
3 new methods are available: 
-Horizontal   -Vertical     -Custom 
 

 

 



 

  

Brise Soleil – Horizontal 

 
 

Brise Soleil – Vertical 

 



 

 

Brise Soleil – Custom – Free form profile 

 



 

  

3.4. Uniforming a staircase contour appearing in various Edit Layout commands  

The lower and upper contours of the stairs are also displayed in the editing commands. This way, you can decide whether 
the stair wall cut command is to hold the stairs above or below the stairs. Structurally, both situations may be justified.

 
 

3.5. Roof with custom shape - cross section profile editable 

When you create a roof with custom shape you sketch the profile first and then use that shape on the roof you create. 
 This profile is available later to edit with Edit section profile command. 
 

 
 

 

  



 

 

3.6. Wall Dimension to Core Layer axis 

You can dimension the axis of the core layer in the wall. 
 
Select the wall dimension command and switch on the Dimension to core layer only and the Dimension the midpoint 
checkbox together. 

 
 

3.7. Wall Dimension to farthest end points 

Building > All Walls dialog Dimension options is extended with this: The farthest end points of the walls. 

 
  



 

  

4. Interior Design Enhancements 

4.1. Tiling with predefined patterns 

Modern tiling layouts require novel interior design solutions. Number of built-in patterns has increased. New patterns: 
Triangle, Benzene, 3 parts hexagon, various Chevron types, Fan, Alhambra. 
 

 
 

 
Examples: www.equipeceramicas.com 

  



 

 

4.2. Tiling by pattern group  

Tiling dialog: Tiling by pattern group is extended with new features to manage row and column shift (Dx and Dy).  

 
 

4.3. Tiling list sorted by rooms 

The Tiling consignation is extended with a new Excel worksheet that lists the tiles sorted by rooms.  
 

 



 

  

4.4. Picture in wall new feature: Managing transparent images 

Images that are saved in PNG format can be transparent. 
The Picture on Wall command has been expanded to handle PNG format images, so you can place any background and 
borderless shape on the wall. 
 

 
 

5. Materials 

5.1. Color Card 

The Colour Card is for replacing a colour or texture with another colour or texture you choose - but this time, the change 
will take place on the entire 3D model. It replaces the used colour or texture with one of the predefined group of elements. 
 
With only one click, you can visualize how the building would look like in an entirely different colour scheme. You can 
either create a new Colour Card, or turn an existing material into a new Card. 
In the Design Center, select the Material panel and In Model category 
Click on a material you are going to convert. Click on Options button and select the command: Convert to Colour Card 
Group. 
 

 
 



 

 

 
 
In the dialog you can add new materials, delete from the group and you can select a new current one.  
When you close the dialog with Ok, the program replaces the given material with the current one.  
Attention the material name remains the same! 
 
You can change the current material from the Color CardArd anytime. Click on the arrow icon in the left top corner of the 
image or click on Options button and Settings command.  
Example:  
 

 
 
Select a new current material. 



 

  

 
 

Output: 

 
 
You can choose a new current material with Settings command too: 

 
  



 

 

6. Visual Enhancements 

6.1. Rendering Styles 

The Render quality and performance parameters are classified into specific groups such as metal, glass, brick, mirror, etc.  
The render styles are optimized groups to visualize the associated quality and performance parameters.  
 
The render styles can be assigned with drag and drop to any materials.  
The effects are visible in internal Rendering application. 
 
The command does NOT change the size and texture of the materials, it replaces the material quality parameters only. 
In addition to the sets, custom settings can be made, but the use of custom properties is primarily recommended for users 
with rendering experience. 
 

  
 
Color coded visualization 

 
Color-coded view enables the classified visualization of render styles.  
Color codes are displayed in the upper right corner of the render style icons. 
Clicking on the Color coded command in the Design Center the ARCHLine.XP displays the model with the pure colors 
assigned to each render style. It makes easy to check render styles assignment through the related colors.  
 

 



 

  

 
Restore view: 
 

 

6.2. Shadow Simulation 

Renewed Shadow Simulation dialog displays the sun path. 

 
 

  



 

 

7. Documentation Enhancements 

7.1. Schedules 

A schedule is a spreadsheet representation of extracted properties of the project elements.  
The schedule lists the selected properties of every instance of any type of element according to schedule's grouping 
criteria. 
Note: This function is disabled in Studio version. 
 
Location of the command: Ribbon > Documentation > Schedule 

About schedules 

You can create and place a schedule at any moment in the project. Any changes that affect then the schedule, will 
automatically update the content of the schedule.  
You can export a schedule to an Excel spreadsheet with Save to Excel command. 
You can apply design phases to a schedule. 

7.1.1. Creating a Schedule 

You can create a new schedule in the Schedule Creation dialog. 
 
Location of the command: Ribbon > Documentation > Schedule > Define schedule 
 

 
 
The dialog is separated into three columns.  
The first column displays automatically the type of element grouping as Architectural elements, Interior and Site. Select 
the type you are going to assign the new schedule. 
The second column displays the General propertes of the selected element, the calculated values and BIM parameter 
groups. Select from the list a property and click on the right arrow button to add this property to the schedule. 
The third column in the dialog displays the schedule template. 

How to create a schedule? 

1. Select the appropriate type of element to create a new schedule (such as a wall schedule). 
2. Select a category from the Group. Select a property from the list. Click on the right arrow to place it into the schedule. 
3. Repeat the step 2. to add more properties to the schedule. 
4. Optionally, sort the schedule template with Up and Down button or Delete the property placed by mistake. 
5. Optionally, format the schedule with Calculate Total, Visible, Prefix, Postfix options. 

7.1.2. Placing Schedule 

Schedules can be placed at any time during the planning process. 

How to place a schedule? 

1. Select the discipline and the appropriate type of element (such as a wall schedule). 
2. Select a Schedule from the Schedules Group.  
3. Optionally you can change the fields for schedule parameters: Calculate total, visibility, prefix and suffix. 



 

  

4. Press Ok to close the dialog and format the schedule in the next dialog before placing. 
 

 
 
After you have selected the type of schedule, you need to specify how the information should display. 
 

 
 
You can specify multiple sorting options by properties (Ascending / descending order, Grouping) and add header, footer, 
and grand-total.  
 
Footer and Grand Totals display the sum of the elements from all the groups. 
Options:  

 Totals: Displays subtotals and gran totals only for those columns that can have them. 
 Totals and title. Displays total and title information. 
 Count totals and title: Title shows the header information. Count shows the number of elements in the group. Totals 

display the total below a column that can have a sum. 
 



 

 

Example: Wall schedule having subtotals and Grand Totals are „Count totals and title”.  

 
 
Grouping. A new blank row displays between the grouped elements, as shown in the following image. 
 

 
 
The schedules can be applied to phase filters. 
You can also choose to list all instances of an element type, or collapse multiple instances onto a single row. 
 
If automatic update is on, changes to the project, that affect the schedule, update the schedule. 
Schedule can be placed on the floor plan and saved in an Excel spreadsheet too. 
 

! Note: You can choose and place a schedule from Project Navigator too. Use Drag and Drop to add a schedule for the 

drawing.  
 



 

  

 

7.1.3. Update Schedule 

As a result of this command, changes to the project, that affect the schedules, update the schedules. 
 
As a result of this command, all schedules update displaying all changes that affect the schedules. 
 
Example: If you change or delete a wall, the wall and room schedule having Footer and Grand Totals are updated 
accordingly. 
 

Editing Cells in a Schedule 

You can edit some cells in a schedule by clicking in them. 
You can either select a value, text or Material name. 
To finish editing in a cell, press Enter. The changes are applied to the appropriate element. 
 
Example:  
1. If you have a door or window schedule and it contains the BIM parameter Manufacturer, click on the field and change 

the manufacturer name. 
2. If you wish to change the wall finish face: Exterior Material click on the material name and select a new material from 

the Material dialog. 
 

7.1.4. Save to Excel 

As a result of this command, the selected schedule is saved in an Excel spreadsheet. 

7.1.5. Exporting Schedule to another User or Project 

You can save the schedule template in an XML format file for use in another project or sending to another user. 



 

 

1. In the Project Navigator, right-click the schedule name, and click Export. You find the same function int he Define 
Schedule dialog clicking ont he Export button. 

2. In the Save As dialog, enter a name for the file, and click Save. 
 
This procedure saves the schedule template. 
 

 
 

7.1.6. Import Schedule  

You can import the schedule template from an XML format file. 
 

1. In the Define Schedule dialog click on the Import button. 
2. Select the schedule file in the Open dialog, and click Ok. 

 
This procedure imports the schedule template. 

 

7.1.7. Save Schedule for use in all projects globally 

You can save the schedule template in an XML format file for use in all projects globally. 
 

1.  In the Project Navigator, right-click the schedule name, and click Save as global.  
2. In the Save As dialog, enter a name for the file, and click Save. 

 
This procedure saves the schedule template. 
 

 

  



 

  

7.2. Compare between 2 design phases 

The function compares two design phases of the same floor plan and displays the graphical changes visually. 
 

 Choose the design phases to compare. 

 Specify different colours for unchanged objects, objects of the first (original) drawing, and objects of the second (new) 
drawing. 

 

 
 
The result is a third drawing which displays the changes between the two phases with the assigned colours. 

 

7.3. Section and Elevation 

The command places two sections across the centre of the model perpendicular to each other (A-A, B-B) and creates the 
four main elevation view in one step 
 
The command is available under the Ribbon bar / Documentation / Section tab. 

 
The setting dialog helps to select which steps you want to activate and what are the main parameters. 
 



 

 

  
 
Screen layout before Section and Elevation command: 

 
 
Screen layout after Section and Elevation command: 

 



 

  

7.4. Horizontal Section 

Horizontal section is representing 3D model as cut horizontally through a certain elevation.  
The command is available under the Ribbon bar / Documentation / Section tab. 

Example: Horizontal section at 1m: 

 

7.5. Roof hatch on floorplan 

When you place a roof on floorplan you can assign a hatch style representing the roof tiles.   
Attention, hatch properties are part of the hatch style, change is possible if you redefine the style. 
 
The Apply hatch on 2D plan is available under the Roof Properties dialog / Pitch and Shape panel. 

 

 
 



 

 

 
  

7.6. Plot Layout: View Titles on Sheets 

When you place a document on Plot Layout, ARCHLine.XP displays the title, such as floor plan and storey, elevation, 
section, and 3D view name. 
The title is Project-specific information and linked to Project Navigator documents name. 
You can rename the title text. The renaming method changes the name of the document in the Project Navigator and on 
the Plot Layout together. 
 

 

  



 

  

8. Minor new features and feature extensions 

8.1. Display door Effective clear width 

 
 

  



 

 

8.2. Length dimension: „Distance and bearing ",  

Displays the length of a drawing (eg land) and the angle of the lines relative to the North. 

 

 

  



 

  

8.3. DWG preview with Unit of Measure pre-setting 

DXF/DWG import dialog is extended with a ruler displaying the current unit of measurement. The unit how to interpret 
the imported drawing can be set as metric or imperial. 

  
 
- DXF/DWG export supports the $INSUNITS and $MEASUREMENT Codes in the HEADER Section Group 

  



 

 

8.4. Wall 1m representation at floor plan for doors and windows. 

Display of openings above cut plane height with two options: Dotted or Not displayed 
 

 
 

 



 

  

8.5. Move wall endpoint command changed to one click command 

 

8.6. Door/window width/height in Properties panel changed to combo box with 
predefined EU and DIN values 

65x210, 75x210, 90x210, 100x210, 140x210, DIN: 63,5x200,5; 76x200,5; 88,5x200,5; 101x200,5 

 

8.7. Lintel (doors and windows) new parameters 

 Name, identifier, cross section representation. 



 

 

 
 
Lintel name can be assigned as consignment parameter and diplayed in Door/window schedules. 

  



 

  

 
  



 

 

8.8. New switch in the Option - Item Settings – Plot Layout Group.  

You can turn off the warning message to update the out of same drawings on the Plot layout:   
„Tracking changes on so the drawings on the  plot layout are updated when the original drawing changes.” 
 

 



 

  

 
 

  



 

 

8.9. Creating terrain road with rounded nodes  

The width of the road and the rounding of the nodes can be specified in the stiles.  Default radius in the nodes is 6m. 

 
 

 

  



 

  

8.10. Import from 3D Warehouse  

The files in 2019 SKP format are downloadable. 

8.11. Roof and slab new feature 

Roof can be dispayed with hatch styles on the floor plan. 

 

8.12. Gable Roof edge material  

Gable Roof edge material management has changed. It applies the top surface material. 

  



 

 

8.13. Creating styles new feature 

Creating styles is optional into the Project only or My (user) category, so it may be usable in every project. 

 

  



 

  

8.14. Improvements of Room and Area 

WOFL norm height and area factor values can be entered in the Options / Global Values panel. 
 

 

8.15. Room summary table automatic update is default 

Any changes on the drawing that modifies the room elements automatically updates the room summary table. 

8.16. Room stamp  

When room is displayed with hatch the room stamp overlaps it.  

  



 

 

8.17. List of floors / roofs in room calculation 

In the room and area dialog, boundary surfaces panel, the program displays the list of floors / roofs that the program uses 
for calculating the boundary for that room. 

 
 

8.18. Other: 

- Making a wall view, the border of the region can be trimmed. 

 


